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Introduction 
In part one of Dashboarding Word, “The Ribbon Untied”, you learned how to 
download, install, and customize the HHS Reports ribbon.  In this segment, “Two 
Panes to Ease Your Pain,” we’ll explore using the wasted space on both sides of 
your document with tools to maximize the ease and efficiency of formatting your 
documents.  Next, in “Templates to Tackle your Troubles” you’ll learn how 
templates can standardize the formatting of all your reports.  By using the 
dashboard and templates together you’ll ensure every report you produce follows 
the HHS branding guidelines and meets accessibility standards. 

Setting up a Dashboard 
To edit and format a document more easily, you should set up a dashboard that 
consists of the HHS Reports tab and these two panes, the Navigation Pane and the 
Styles Pane. This dashboard will also help you determine if a Word document is 
accessible. 

If you are using the default ribbon in Word: 
• The Navigation Pane is opened by clicking the View tab and then selecting 

the Navigation Pane checkbox in the Show group.

 
• The Styles Pane is opened by clicking the Home tab and then selecting the 

very small Expand icon in the Styles group. 
 

 

You may remember from “The Ribbon Untied”, one of our goals in this training is to 
increase your efficiency with using Word; so, if you’ve installed the HHS Reports 
tab, two simple clicks under this one tab will show you these panes. 
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If you are using the HHS Reports tab: 
• The Navigation Pane is opened by clicking the Doc. Nav. command in the 

Structure group. 
• The Styles Pane is opened by clicking the Styles command in the 

Structure group. 
 

 

These panes make common formatting tasks and navigation within Microsoft Word 
easier  
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Now that we have our dashboard ready to go, let’s open an existing HHS Report 
that is already using the standard HHS Report Template.  I’m going to open the 
Texas Medicaid Drug Donation Study report.  Now that we have an example in front 
of us, let’s explore the power behind these two panes. 

Document Navigation Pane Overview 
The Document Navigation Pane is mainly used to, well, navigate the document. 

In the Navigation Pane, we see that it has three views: 
1. The HEADINGS view shows a list of actual headings in the document.  

Actual headings add information that lets software recognize the outline 
structure of the document.  So, if the Heading view shows a complete and 
correct outline of your document: 

● Word can also build the Table of Contents for you. 
● Screen readers can build that Table of Contents for their users, even if 

you don’t. 
By using actual headings, you make your document more accessible and 
more usable for everyone. 
In our example document, we can see all of the headings and subheadings 
listed in the Navigation pane.  If we want to read about the quality control 
process stated in this report, we simply select the Quality Control heading, 
and the document is scrolled to that selection for viewing and/or editing. 
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Often, people make text look like a heading without making it an actual 
heading.  If we don’t designate the style of the text as a heading, our 
software, Word or Screen Readers, won’t recognize or treat it as a heading.  
Let’s add an Imposter Heading to our example document.  We’ll slip it in 
here between these two paragraphs.  In order to make it look just like our 
Heading 2 style, we’ll select Quality Control and use the Format Painter tool 
to format our Imposter Heading.  (Remember, we are creating a bad 
example here.  Avoid using the formatting tools on the Home tab.  These 
tools will often lead to poor document structure, inconsistent formatting, and 
ultimately inaccessibility.) 
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Now, back to our example.  Even though it looks just like a Heading 2: 
● It won’t be displayed in the Headings view of the Navigation pane. 
● Word will not include it in the generated Table of Contents. 
● Screen readers will not list it as a user navigates through the document 

headings. 
Because they look like headings but don’t act like headings, we call them 
imposter headings.  Whenever headings in the document don’t appear in the 
Navigation pane, you know that software can’t include that heading in the 
outline structure of the document. 
Since we have our dashboard for Word open and ready to go, making our 
Imposter Heading into an actual Heading is very simple.  Just select it and 
set the style.  For this example we’ll use Heading 2.  Just like magic it 
appears in our Navigation pane.  We can even edit it in our document and 
our outline is changed in real time. 

2. The PAGES view shows thumbnail previews of each page. These previews 
can help you find and navigate to pages with phrases, tables, charts, or even 
graphics.  The PAGES view is a useful feature when you’re searching a 
document.  By entering a word or phrase in the search field, at the top of the 
Navigation pane, only the pages containing that word or phrase are 
displayed.  If we need to find all the references to the acronym ITEAMS, type 
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that into the search field.  We can easily see that it’s on pages 9 and 11. 

 
3. The RESULTS view also shows search results. It tells how many times the 

word or phrase appears in the document, and it displays the word or phrase 
in context by showing a snippet of the surrounding text.  You can skim the 
results, find the instance you’re interested in, and select that instance in the 
RESULTS view to go straight to it in the document. 
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Another powerful tool the Search entry field offers, is the ability to search for 
object types in your document.  By selecting the drop-down arrow from the 
search entry field, we can find Graphics, Tables, Equations, 
Footnotes/Endnotes, and comments.  In order for our document to be 
accessible, all informational graphics should be “In Line with Text” and have 
“Alt Text” defined.  We can use this tool to ensure our graphics are 
accessible.  Let’s find our graphics.  Now with our HHS Reports tab selected, 
we can easily see that our graphic is “In Line with Text” because that 
Graphics tool is highlighted.  If it’s not highlighted, we can simply select that 
tool and Word will put that graphic in line with text.  We can also select the 
Alt Text tool to verify or define the Description entry field.  We find two 
graphics in our example document.  The first, our logo, is defined in the 
template as a background object and is not necessary to be deemed as an 
accessible graphic.  The second graphic, our hospitals in Texas map, is 
important information to all readers of our document.  We can quickly see 
that this graphic is both in line with text and the description is defined.  Now 
that’s a very powerful way to ensure accessibility in our documents. 

Using the Document Navigation Pane 
Now that we know the basics of the Document Navigation pane and some of its 
power, we’ll explore more of its functionality.  
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Let’s look at some examples of navigating the document with the Navigation Pane. 
First, we will examine some headings to see how they play an important role in 
making a document accessible. 

● Select a heading in the Navigation pane.  Instantly, Word moves to that 
heading in the document.  This is a great way to traverse through your 
document. 

● You may also notice that as we scroll through the document, the heading for 
the current section is highlighted.  I use this feature quite often to ensure I 
remain “on-topic” while writing a document.  Whatever I’m typing should 
pertain to the highlighted heading in the Navigation pane. 

The Navigation Pane can also be used to DRIVE the creation of your document and 
later help MODIFY your document. Let’s look at a typical scenario: 

When we create a new document there are no headings in the Navigation pane.  
But Word is kind enough to remind us what we learned in elementary school, 
“Create an interactive outline of your document.” 

 

Add Headings to a Document 
We should start our document by taking both Word’s and Mrs. Abernathy’s advice.  
We’ll start by creating an outline.  The outline for the example document we looked 
at earlier probably looked something like this: 
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Now that we have our outline listed, let’s style each topic with the appropriate 
heading style.  Place the cursor at the beginning of the line and select the desired 
Heading style from the Styles pane.   Since I’m using the HHS Reports Template 
styles, I’m going to select the Heading 1-No Numbering for the Executive 
Summary style.  With the selection of that heading style, that topic is now 
formatted to the HHS Standard font, color, background, size, and alignment for a 
Heading 1.  You may also notice it now appears in our Navigation pane.  Now I’ll 
make Introduction and Potential Drug Doors numbered Heading 1’s.  Since 
the Hospitals, Nursing Homes, and Other Health Facilities topics are all 
subtopics of Potential Drug Donors they should be designated as a Heading 2 
style.  I’ll simply select all three lines and choose Heading 2 from my Styles pane.  
Now those topics take on the standard characteristics and they appear in the 
Navigation pane indented under the Potential Drug Donors heading.  Now I’ll 
finish the remaining headings, and we’ll be ready to write our content.  
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It’s best practice to create headings first and then add content between them later. 
This will help you to see the “big picture” of how topics are related and how you can 
modify them before you add content to your document.  

Now, let’s return to our example report and continue exploring the powerful 
features of the Navigation pane.  

Promote & Demote Headings 
After some careful consideration, I think that it would be better to change some of 
these headings. Microsoft Word allows you to PROMOTE or DEMOTE the levels of 
headings rather easily.   

Here, I’ll select Quality Control in the Navigation pane, right-click it, and select 
Promote to promote it to a Heading 1.  By selecting the Promote option, the topic 
took on all of the characteristics of a Heading 1 and it even renumbered all of our 
Heading 1 topics.  Think of all the work we would have done without using the 
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Navigation pane and Styles.  It would’ve been a real pain.

  

If a particular topic has subtopics, all of the subtopics will also follow suit with the 
promotion or demotion.  Since we promoted Quality Control, it gained three 
subtopics.  Now if we DEMOTE Quality Control, it will also DEMOTE the three 
subtopics to a Heading 3.
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Since we’re on the topic of subtopics, you may have noticed the small triangles 
denoting heading levels which have other headings NESTED under them. By 
selecting the solid triangles, the subtopics or nested headings will collapse under 
their parent heading.  Adversely, selecting the outlined triangle will expand the 
main topic so that we can see all the subtopics.  This comes in very handy when 
you’re dealing with a very large document.  
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Figure 1: Here we see Quality Control Expanded. 

 

Figure 2: Here we see Quality Control Collapsed. 

Move a Heading and its Content 
Now that we’ve promoted and then demoted the Quality Control heading in our 
example, we may even decide that we need to move that topic up in our document.  
We can simply drag the Quality Control heading up to the beginning of the Drug 
Donation Program Oversight and Administration section.  Notice as we drag the 
topic up, all of the subtopics move up with it. 
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Now we can reorganize our document in seconds.  It sure beats having to cut and 
paste entire sections and losing our place in the report. 

Delete a Heading and its Content 
There are times, after writing our document, we decide that a topic we added in our 
original outline doesn’t belong in our report after all.  By right-clicking on a 
heading, we can choose Delete from the context menu that opens.  This delete 
function will delete the heading, the content under the heading, and all of its sub-
headings as well.  It’s a great tool to use when you need to trim down your 
document, but use it carefully.  And remember, Undo is our friend. 

Create TOC from Heading Levels 
An advantage to formatting and viewing all your headings in the Document 
Navigation pane is that you can see how Word will create your document’s Table of 
Contents.  If we place our cursor at the beginning of the document and choose the 
Automatic Table 1 from the TOC tool on the HHS Reports tab, Word will create our 
Table of Contents based on the headings in the Navigation pane.
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Wow! Check out that resemblance.  Now you can see how important the Navigation 
pane is to your document creation process.  It’s like having the table of contents, 
your document’s roadmap, visible at all times. 

Styles Pane Overview 
In the Styles Pane, its default view shows the style names and elements that can 
be applied to your document, such as block level elements like entire paragraphs, 
line level elements such as titles and heading, and even character level formatting 
to draw attention to single words or phrases.  Styles not only help us define our 
navigational elements like headings, they keep our document formatting consistent 
throughout the document.  Whether it’s a word we want to emphasize by making it 
Strong or an Intense Quote that we really want to standout, styles are the key to 
formatting your document. 
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If you click the Show Preview checkbox, each style will display the ACTUAL 
formatting that will be APPLIED to structural elements in the document.  This is 
very helpful for anyone that is a first time user of styles.  It allows you to see what 
you’re going to get before choosing that style. 
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Styles represent ROLES for both structure and format for specific structural 
elements (e.g., headings, bullet or number lists, and paragraphs) in a document. 
When used properly, styles can enhance the readability and the accessibility of a 
Word document. 
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Using the Styles Pane 
As mentioned earlier, the Styles pane can be used to PREVIEW and APPLY 
available styles to elements in your document.  Setting your text to a particular 
style is very easy.  Highlight the text that you would like to style and select that 
style from the Styles pane.  If selecting a line structured style, the cursor can be 
placed anywhere on that line and that entire line will take on that style.  I prefer 
selecting my text and selecting its style.  After all, Cornelius says it best: 

Whatever is selected gets effected.  

Making Your Own Style 
We’ve already learned the power behind the Navigation pane.  Styles also have 
their own super powers.  Ensure that everything in your document has a style.  
Resist the urge to change a block of text by using the tools on the left of the Home 
tab.  Rather than making a word bold with the bold tool, change the style of that 
word to Strong, or create a Bold style. 

Let’s create a hypothetical example using our Medicaid Drug Donation Study report.  
We want our reader to know the importance of our organization in the Quality 
Control section.  In this case it’s DSHS.  Using our Navigation pane powers we 
learned earlier, we can find all references to DSHS.  In that section we’ll go through 
each result and change the style to Strong.  Now DSHS in this document section 
has taken on a styled role.  

If you hover over the right side of a style in the Styles pane and click on the down 
arrow, you will be able to: 

1. Update the look of a style based on the format of your selected text.  
2. Modify an existing style. 
3. Select or remove all instances of styles in the document. 
4. Delete a style. 
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If we want to change a particular style we can change that style once and 
everything assuming that role will change.  Let’s not only make our Strong style 
Bold.  Let’s make it big.  Choose “Modify…” from the Strong style menu.  Let’s 
make the font size 20.  Now everything in our document using the Strong style is 
big and bold. 

Once styles are assigned, changing the way they look is relatively easy and can be 
done for various reasons.  Users with low vision may set their styles larger.  Since 
styles can be inherited, setting the Normal style to a larger size will increase the 
size of all the other styles that are based off of Normal.  Other people with low 
vision also like to underline headings; so that when the screen is magnified 
headings can be recognized even if the words aren’t on the screen.  HHS has a set 
of styles defined to ensure consistency across organizations under the HHS 
umbrella.  We’ll show you how to use these styles in the next video, “Templates to 
Tackle Your Troubles.” 

Conclusion 
In this video, you learned how to use the Document Navigation and Styles panes 
and how they can help you determine if a document has the proper structure and 
styles. When headings and styles are used properly in a document, it will be easier 
to navigate for everyone. A well-structured document will also be more accessible 
to people using assistive technology (AT) such as screen readers.  
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